
Q.1 Which output device is specifically designed to produce high-quality printed
graphics and text?

Ans 1. Dot Matrix Printer

2. Projector

3. Joystick

4. Inkjet Printer

Q.2 According to the United Nations Convention on the Law of the Sea (UNCLOS), India’s
Exclusive Economic Zone (EEZ) extends upto __________.

Ans 1. 400 nautical miles

2. 200 nautical miles

3. 300 nautical miles

4. 500 nautical miles

Q.3 The quadratic equation 2x2 + 4x + 8 = 0 has:
Ans 1. no real roots

2. two distinct real roots

3. two equal real roots

4. more than 2 real roots

Q.4 In Windows 10 File Explorer, how can you group files by their type?
Ans 1. Rename all files with the same type

2. Use the 'View' tab and select 'Details'

3. Use the 'Sort by' option and select 'Name'

4. Use the 'Group by' option and select 'Type'

Q.5 A can finish a work in 2 days and B can do the same work in 52 days. B worked alone
for 26 days and left the job. In how many days can A alone finish the remaining work?

Ans 1. 4

2. 1

3. 3

4. 2

Test Center Name iON Digital Zone iDZ Akshay Colony
Test Date 11/06/2025
Test Time 12:45 PM - 2:15 PM
Subject RRB NTPC Graduate Level I
* Note
Correct Answer will carry 1 mark per Question.
Incorrect Answer will carry 1/3 Negative mark per Question.

1. Options shown in green color with a tick icon are correct.
2. Chosen option on the right of the question indicates the option selected by the candidate.
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Q.6 What is the standard method to save your work in PowerPoint?
Ans 1. Click on the Insert tab

2. Select 'Save' from the Design tab

3. Exit the program without saving

4. Use the File tab and select 'Save' or press Ctrl + S

Q.7 The mean and the mode of a set of data are 47.4 and 61.6, respectively. Find the median
of the data set, using the empirical formula.
(Round off your answer to one decimal place.)

Ans 1. 53.8

2. 51.7

3. 52.1

4. 52.7

Q.8 Which of the following statements is true about the Permanent Lok Adalat under
Section 22-B of The Legal Services Authorities Act, 1987?

Ans 1. The award of the Permanent Lok Adalat is not binding on the parties.

2. The Permanent Lok Adalat can only act as a conciliator and cannot decide disputes.

3. The Permanent Lok Adalat has jurisdiction over disputes related to criminal offences.

4. The Permanent Lok Adalat can handle cases up to a certain monetary limit (currently
₹1 crore).

Q.9 P is a point outside a circle and is 17 cm away from its centre. A secant drawn from the
point P intersects the circle at points A and B in such a way that PA = 8 cm and AB = 7
cm, where PB > PA. The radius of the circle is:

Ans 1. 12 cm

2. 15 cm

3. 14 cm

4. 13 cm

Q.10 The sum of the age of A and 4 times the age of B is 34 years. When 3 times the age of A
is added to 7 times the age of B, the result is 97 years. The sum of the ages (in years) of
A and B is:

Ans 1. 28

2. 30

3. 33

4. 31

Q.11 A man spends 40% of his monthly salary on house rent. If every month, he also spends
₹442 on conveyance and ₹9,115 on grocery and saves the remaining ₹946, his monthly
salary is:

Ans 1. ₹17,468

2. ₹17,603

3. ₹17,475

4. ₹17,505

Q.12 Town P is to the east of Town Q. Town Q is to the south of Town R. Town R is to the east
of Town S. Town S is to the west of Town T. Town P is to the south-west of Town T. What
is the position of Town R with respect to Town T?

Ans 1. South

2. North

3. East

4. West
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Q.13 A trader lost 5% by selling a shirt for ₹950. He will gain x% by selling it for ₹1,360. The
value of x is:

Ans 1. 26

2. 46

3. 36

4. 51

Q.14 What is the mode of the following data?
77, 86, 89, 74, 69, 84, 87, 80, 60, 64, 79, 63, 83, 82, 81, 89, 80, 69, 73, 74, 87, 68, 74, 77, 67,
74

Ans 1. 77

2. 74

3. 86

4. 89

Q.15 The Maitrakas of Valabhi were initially the:
Ans 1. subordinates of the Guptas

2. part of the Hunas

3. rivals of the Guptas

4. rulers of an independent empire

Q.16 In a certain code language,
'A + B' means 'A is the mother of B',
'A – B' means 'A is the brother of B',
'A × B' means 'A is the wife of B' and
'A ÷ B' means 'A is the father of B'.

Based on the above, how is M related to Q if 'M – N ÷ O + P × Q'?
Ans 1. Wife's Mother's Father's Brother

2. Wife's Father's Father

3. Wife's Father's Brother

4. Wife's Mother's Father

Q.17 Seven boxes, D, E, F, G, S, T and U, are kept one over the other but not necessarily in
the same order. Only two boxes are kept between T and E. Only S is kept above G. No
box is kept below E. D is kept at some place below F but at some place above U. Which
box is kept third above U?

Ans 1. G

2. D

3. F

4. T

Q.18 From a point 15 m away from the base of a tree, the angle of elevation to the top is 45°.
What is the height of the tree?

Ans 1. 15 m

2. 18 m

3. 10 m

4. 12 m
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Q.19 35 is related to 70 following a certain logic. Following the same logic, 24 is related to 48.
To which of the following is 11 related, following the same logic?

(NOTE: Operations should be performed on the whole numbers, without breaking down
the numbers into their constituent digits. E.g. 13 – Operations on 13 such as
adding/subtracting/multiplying to 13 can be performed. Breaking down 13 into 1 and 3
and then performing mathematical operations on 1 and 3 is not allowed.)

Ans 1. 22

2. 20

3. 21

4. 23

Q.20 Which feature of the phosphodiester bond contributes most to the overall negative
charge of the DNA molecule?

Ans 1. The methyl group of thymine

2. The ribose sugar

3. The nitrogen in purines

4. The phosphate group’s ionisable oxygen atoms

Q.21 This question is based on the five, three-digit numbers given below.

(Left) 236 758 230 563 263 (Right)

(Example- 697 – First digit = 6, second digit = 9 and third digit = 7)
(NOTE: All operations to be done from left to right.)

What will be the resultant if the first digit of the lowest number is subtracted from the
first digit of the highest number?

Ans 1. 6

2. 8

3. 4

4. 5

Q.22 Which of the following rivers flows through Rajasthan?
Ans 1. Luni

2. Jhelum

3. Teesta

4. Tapi

Q.23 What is the central theme of the first five anthologies (Kuruntokai, Narrinai, Akananuru,
Ainkurunuru, and Kalittokai) of the Ettuttokai in the Sangam literature?

Ans 1. Akam

2. Philosophy

3. Puram

4. Religion

Q.24 Which of the following tree species is an example of deciduous vegetation in India?
Ans 1. Bamboo

2. Babool

3. Deodar

4. Sal
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Q.25 The Charter Act of 1833 created a separate ______.
Ans 1. Law Commission in India

2. Supreme Court in Madras

3. Federal Court

4. Legislative Assembly in Delhi

Q.26 Which of the following letter-clusters should replace # and % so that the pattern and
relationship followed between the letter-cluster pair on the left side of :: is the same as
that on the right side of :: ?
# : LIE :: SPL : %

Ans 1. # = OLH, % = PMI

2. # = PQH, % = GVI

3. # = OLT, % = OAI

4. # = OOI, % = PDF

Q.27 The average of Anwar's marks in seven subjects is 75. His average in six subjects
excluding Science is 70. How many marks did he get in Science?

Ans 1. 107

2. 104

3. 105

4. 106

Q.28 As per the SDG India Index 2023-24, what was the estimated percentage of reduction in
the population living in multidimensional poverty between 2015-16 and 2019-21?

Ans 1. From 24.8% to 14.96%

2. From 30% to 20%

3. From 20% to 12%

4. From 15% to 10%

Q.29 In December 2024, India mourned the passing of Dr Manmohan Singh. In which year did
Dr Manmohan Singh first become the Prime Minister of India?

Ans 1. 2001

2. 1999

3. 1991

4. 2004

Q.30 A hollow spherical shell is made of a metal of density 21 g/cm3. Its internal and external
radii are 8 cm and 9 cm, respectively. What is the weight (in kg) of the shell?

Ans 1. 20.34

2. 16.096

3. 19.096

4. 21.03

Q.31 Which Indian state shares its border with Bhutan and Bangladesh?
Ans 1. Assam

2. Meghalaya

3. Sikkim

4. Mizoram
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Q.32 The average of three numbers is 23. If two numbers are 11 and 25, the third number is:
Ans 1. 32

2. 34

3. 33

4. 35

Q.33 What will come in place of the question mark (?) in the following equation if '÷' and '–'
are interchanged and '×' and '+' are interchanged?

56 + 41 ÷ 12054 – 123 × 891 = ?
Ans 1. 1307

2. 3089

3. 1557

4. 811

Q.34 Who among the following is appointed as the President of the upcoming COP30
Summit?

Ans 1. André Aranha Corrêa do Lago

2. Luiz Inácio Lula da Silva

3. Marina Silva

4. Jair Bolsonaro

Q.35 Which of the following letter-clusters should replace # and % so that the pattern and
relationship followed between the letter-cluster pair on the left side of :: is the same as
that on the right side of :: ?

# : NHP :: RLT : %
Ans 1. # = OIQ , % = QKR

2. # = OIQ , % = QKS

3. # = OIQ , % = QLS

4. # = OIR , % = QKS

Q.36 Which of the following is the primary basis for allocating seats in the Rajya Sabha
among various States and Union Territories in India?

Ans 1. Economic contribution of each state

2. Literacy rate of the population

3. Population of each state or union territory

4. Geographical area of each state

Q.37 In a certain code language, ‘LATE’ is coded as ‘8054’ and ‘TEAM’ is coded as ‘4087’.
What is the code for ‘M’ in the given code language?

Ans 1. 7

2. 0

3. 4

4. 8

Q.38 Which is NOT an advantage of a Lok Adalat?
Ans 1. No court fees

2. Binding decisions

3. Right to appeal

4. Speedy resolution
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Q.39 Mr. T starts from Point D and drives 3 km towards the east. He then takes a right
turn, drives 7 km, turns right and drives 6 km. He then takes a right turn and
drives 4 km, and then turns right and drives 3 km. He takes a final left turn, drives
1 km and stops at Point H. How far (shortest distance) and towards which
direction should he drive in order to reach Point D again? (All turns are 90
degree turns only unless specified.)

Ans 1. 7 km towards the west

2. 5 km towards the east

3. 2 km towards the south

4. 2 km towards the north

Q.40 In a certain code language, ‘PACE’ is coded as ‘2468’ and ‘COST’ is coded as ‘1327’.
What is the code for ‘C’ in the given code language?

Ans 1. 6

2. 7

3. 2

4. 1

Q.41 Which of the following letter-number clusters will replace the question mark (?) in the
given series to make it logically complete?

EK19, GM28, IO37, KQ46, ?

Ans 1. MR56

2. MS56

3. MS55

4. MR55

Q.42 What should come in place of the question mark (?) in the given series?

402 400 396 390 382 ?
Ans 1. 374

2. 372

3. 376

4. 370

Q.43 In February 2025, the Broadcast Services Regulation Bill, 2023 was introduced in the
Parliament. What is a key provision under this draft legislation?

Ans 1. Mandatory pre-censorship of digital news content

2. Ban on airing foreign content between 7 p.m. and 10 p.m.

3. Transfer of all broadcasting regulation powers to state governments

4. Unified regulation of cable, satellite and OTT platforms

Q.44 The population of a village was 1,10,000. It increased by 5% in the first year and
increased by 25% in the second year. Its population after two years is _______.

Ans 1. 1,43,000

2. 1,44,375

3. 1,37,500

4. 1,15,500
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Q.45 “Swadesh Sevak Home” is related to which of the following national freedom
initiatives?

Ans 1. Non-Cooperation Movement

2. Ghadar Movement

3. Home Rule Movement

4. Swadeshi Movement

Q.46

Ans 1. 56 minutes

2. 49 minutes

3. 42 minutes

4. 50 minutes

Q.47 Based on the English alphabetical order, three of the following four letter-cluster pairs
are alike in a certain way and thus form a group. Which letter-cluster pair DOES NOT
belong to that group?
(Note: The odd one out is not based on the number of consonants/vowels or their
position in the letter-cluster.)

Ans 1. YV−WT

2. NK−LI

3. KH−HH

4. TQ−RO

Q.48 Given that 1460.93 = x, 1460.22 = y and xz = y7, then the value of z is close to:
Ans 1. 1.66

2. 5.05

3. 2.61

4. 3.6

Q.49 Two positive numbers differ by 2858. When the greater number is divided by the smaller
number, the quotient is 5 and the remainder is 178. What is the HCF of the greater of the
two given numbers and 3828?

Ans 1. 13

2. 17

3. 11

4. 12

Q.50 A, B, C, D, R, S and T are sitting around a circular table facing the centre of the table. B
sits fourth to the right of R. Only two people sit between T and D when counted from the
left of T. A sits third to the left of C. S is an immediate neighbour of C and D. How many
people sit between B and S when counted from the left of S?

Ans 1. Four

2. Two

3. Three

4. One
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Q.51

Ans 1. 

2. 

3. 

4. 

Q.52 If '+' means '−', '−' means '×', '×' means '÷' and '÷' means '+', then what will come in place
of the question mark (?) in the following equation?

55 – 8 ÷ 3 + 15 × 5 = ?
Ans 1. 450

2. 420

3. 440

4. 400

Q.53 Akshay has ₹1,218 with him. He divided it amongst his sons Arjun and Kartik and asked
them to invest it at 10% rate of interest per annum, compounded annually. It was seen
that Arjun and Kartik got the same amount after 12 and 13 years, respectively. How
much amount (in ₹) did Akshay give to Kartik?

Ans 1. ₹580

2. ₹430

3. ₹738

4. ₹638

Q.54

Ans 1. Square

2. Kite

3. Trapezium

4. Rhombus

Q.55 Seven boxes, A, B, C, D, E, F and G, are kept one over the other but not necessarily in
the same order. Only three boxes are kept below B. Only two boxes are kept between B
and G. Only A is kept immediately above E. F is kept in some place below D and in some
place above C. How many boxes are kept below C?

Ans 1. 1

2. 3

3. 2

4. 4

Q.56 According to the Periodic Labour Force Survey (PLFS) report, what was the Labour
Force Participation Rate (LFPR) for women in 2021-22?

Ans 1. 14.8%

2. 23.5%

3. 32.8%

4. 42.7%
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Q.57 C is the third proportional of 29 and B. If B is the sum of the first three even natural
numbers, then find the value of C.
(Rounded off to two decimal places)

Ans 1. 3.85

2. 7.64

3. 4.97

4. 3.53

Q.58 C, O, U, N, T, and Y live on six different floors of the same building. The lowermost floor
in the building is numbered 1, the floor above it, number 2 and so on, till the topmost
floor is numbered 6. Only two people live above C. Only two people live between C and
T. Only N lives between C and U. Y lives immediately below C. Who lives on the floor,
numbered 2?

Ans 1. T

2. U

3. N

4. O

Q.59 Who among the following has been appointed as the Private Secretary to the Prime
Minister Narendra Modi in March 2025?

Ans 1. Amitabh Kant

2. Ajay Bhadoo

3. Nidhi Tewari

4. Anju Rathi

Q.60 The Maski Ashoka Inscription is situated in which state of India?
Ans 1. Bihar

2. Odisha

3. Andhra Pradesh

4. Karnataka

Q.61 A shopkeeper marks the price of an article at ₹5,960. Find the cost price if after allowing
a discount of 9% he still gains 30% on the cost price.

Ans 1. ₹4,142

2. ₹4,154

3. ₹4,172

4. ₹4,277

Q.62 What was the sex ratio in India as per the 2011 Census data?
Ans 1. 950 females per 1000 males

2. 948 females per 1000 males

3. 943 females per 1000 males

4. 940 females per 1000 maleswww.go
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Q.63 T travelled 576 km, 630 km and 315 km at the speeds of 16 km/hr, 7 km/hr and 9 km/hr,
respectively. Find his average speed in km/hr.

Ans
1. 

2. 

3. 

4. 

Q.64 Which of the following numbers is divisible by both 6 and 31?
Ans 1. 3720

2. 2858

3. 2132

4. 4916

Q.65 Based on the English alphabetical order, three of the following four letter-clusters are
alike in a certain way and thus form a group. Which letter-cluster DOES NOT belong to
that group?
(Note: The odd one out is not based on the number of consonants/vowels or their
position in the letter-cluster.)

Ans 1. QRU

2. LKP

3. EFI

4. MNQ

Q.66 If 1 is added to each odd digit and 2 is subtracted from each even digit in the number
3816427, how many digits will appear more than once in the new number thus formed?

Ans 1. Two

2. Four

3. Three

4. One

Q.67 The product of two consecutive positive integers is 960. If the smaller of these two
integers is represented by x, which of the options below will correspond to the equation
for finding the value of x?

Ans 1. x2 − x − 960 = 0

2. x2 + x − 960 = 0

3. x2 − x + 960 = 0

4. x2 + x + 960 = 0

Q.68 Which of the following ratios is the greatest?
Ans 1. 33 : 51

2. 32 : 86

3. 26 : 59

4. 37 : 64
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Q.69 In February 2025, what was the protein isoform '1N4R tau' identified by the University of
Cologne being explored for?

Ans 1. Preventing insulin resistance

2. Treating Alzheimer’s disease

3. Managing chronic kidney disorders

4. Curing sickle cell anemia

Q.70 Which of the following statements regarding the Supreme Court's interim order in the
Ranveer Allahbadia case (February 2025) is/are correct?
The Supreme Court granted interim protection to Allahbadia but harshly criticised his
remarks as obscene and vulgar.
The Court ruled that Allahbadia was free to travel abroad without any restrictions since
the remarks were made behind a paywall.

Ans 1. Only 1

2. Both 1 and 2

3. Neither 1 nor 2

4. Only 2

Q.71 Who was appointed the new Director General of the International Solar Alliance (ISA) in
November 2024?

Ans 1. RK Singh

2. Upendra Tripathy

3. Ajay Mathur

4. Ashish Khanna

Q.72 What happens when you use the Format Painter tool in MS Word?
Ans 1. It deletes the selected text.

2. It inserts a hyperlink.

3. It changes the page orientation.

4. It copies formatting (e.g., font, color) from one piece of text to another.

Q.73 VBDP is related to ZWHK in a certain way based on the English alphabetical order. In
the same way, DRLF is related to HMPA. To which of the following is LHTV related,
following the same logic?

Ans 1. OCWR

2. QBYR

3. QDYP

4. PCXQ

Q.74 In November 2024, NITI Aayog launched the 'Accelerating Sustainable State Energy
Transition (ASSET)' initiative. What is the primary objective of this initiative?​

Ans 1. To develop nuclear energy infrastructure across states

2. To promote electric vehicle adoption in urban areas

3. To enhance energy efficiency in industrial sectors

4. To support states in achieving their renewable energy targets

Q.75 In acidic medium, the balanced redox reaction for MnO₄⁻ + Fe²⁺ → Mn²⁺ + Fe³⁺ is:
Ans 1. MnO₄⁻ + 3Fe²⁺ + 2H⁺ → MnO₂ + Fe³⁺ + H₂O

2. MnO₄⁻ + 2Fe²⁺ + H₂O → Mn²⁺ + Fe³⁺

3. MnO₄⁻ + 5Fe²⁺ + 8H⁺ → Mn²⁺ + 5Fe³⁺ + 4H₂O

4. MnO₄⁻ + Fe²⁺ → MnO₂ + Fe³⁺
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Q.76 Who among the following won the 2024 US Open Women's Singles title?
Ans 1. Elena Rybakina

2. Aryna Sabalenka

3. Iga Świątek

4. Coco Gauff

Q.77 In this question, a group of numbers is coded by using letters and symbols as per the
table given below and the conditions which follow.

Number 7 8 2 3 4 5 6
Code Z Q # @ % $ U

Conditions:
1. If the 1st and 2nd digits are even, both are to be coded as ‘A’.
2. If the 1st and last digits are odd, both are to be coded as the code for the 1st digit.
3. If the 3rd and 4th digits are even, their codes are to be interchanged.

What is the correct combination of codes (by following only the applicable condition(s))
for the given digits?

48719

Ans 1. A A Z J S 

2. % % Z J S 

3. Q Q Z J S 

4. % Q Z J S

Q.78 After allowing a discount of 80%, the value of an oven is ₹5,180. If no discount is
allowed, then the shopkeeper gains 48%. Find the cost price (in ₹) of the oven.

Ans 1. 17,501

2. 17,503

3. 17,500

4. 17,502

Q.79 Pipes A and B can fill an empty cistern in 84 minutes and 36 minutes, respectively. Both
Pipe A and Pipe B are opened together. After how much time should Pipe B be turned
off so that the empty cistern is completely filled in a total of 42 minutes?

Ans 1. 18 minutes

2. 24 minutes

3. 12 minutes

4. 15 minutes

Q.80 What will come in the place of the question mark (?) in the following equation, if ‘+’ and
‘−’ are interchanged and ‘×’ and ‘÷’ are interchanged?

151 ÷ 3 + 168 × 8 − 145 = ?
Ans 1. 557

2. 567

3. 547

4. 577
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Q.81 Which of the following letter-clusters should replace # and % so that the pattern and
relationship followed between the letter-cluster pair on the left side of :: is the same as
that on the right side of :: ?

# : NHO :: SMT : %
Ans 1. # = PJO, % = QKR

2. # = PJQ, % = QKR

3. # = PJQ, % = QKS

4. # = PJQ, % = QLR

Q.82 Read the given statements and conclusions carefully. Assuming that the information
given in the statements is true, even if it appears to be at variance with commonly
known facts, decide which of the given conclusion(s) logically follow(s) from the
statements.

Statements:
Some water is pink.
All pink are buildings.
All buildings are tall.

Conclusions:
(I) Some pink is water.
(II) Some buildings are pink.

Ans 1. Neither conclusion (I) nor (II) follows.

2. Only conclusion (II) follows.

3. Only conclusion (I) follows.

4. Both conclusions (I) and (II) follow.

Q.83 Which of the following statements about Small Causes Courts is correct?
Ans 1. Their decisions are final but subject to High Court’s revision.

2. They deal exclusively with criminal cases of a minor nature.

3. They exist in all states under a uniform nomenclature.

4. They can hear appeals from Nyaya Panchayats.

Q.84 Which seasonal change marks the withdrawal of monsoon in India?
Ans 1. Southward shift of ITCZ

2. Rise in daytime temperature

3. Onset of monsoon

4. Return of polar jet

Q.85 What should come in place of the question mark (?) in the given series?

99 92 105 98 111 104 ? 110
Ans 1. 92

2. 117

3. 97

4. 125

Q.86 The volume of a right circular cone is 1078 cm3. Find the total surface area of the cone if
its height is 21 cm. (Use π = 22/7)

Ans 1. 

2. 154 cm2

3. 

4. 
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Q.87 What was the life expectancy at birth in India as per the 2021 World Health Organization
data?

Ans 1. 67.3 years

2. 70.8 years

3. 65.3 years

4. 72.1 years

Q.88

Ans
1. 

2. 

3. 

4. 

Q.89 What was the unknown element under aluminium called?
Ans 1. Eka-Aluminium

2. Neo-Aluminium

3. Meta-Aluminium

4. Proto-Aluminium

Q.90 Refer to the following number and symbol series and answer the question that follows.
Counting to be done from left to right only.

(Left) 1 6 $ 1 * 6 5 9 6 % % 1 * * £ 2 * 6 5 $ @ 6 (Right)

How many such numbers are there each of which is immediately preceded by a number
and also immediately followed by a symbol?

Ans 1. 5

2. 4

3. 2

4. 3

Q.91 Which of the following cities hosted the important 20th Dialogue event in December
2024?

Ans 1. Riyadh, Saudi Arabia

2. Manama, Bahrain

3. Doha, Qatar

4. Abu Dhabi, UAE

Q.92 Singphos’ Rebellion is associated with which region of present day India?
Ans 1. Arunachal Pradesh

2. Assam

3. Manipur

4. Tripura
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Q.93 P, Q, R, S, T, U and V are sitting around a circular table facing the centre. Only two
people sit between T and Q when counted from the left of Q. U sits third to the left of S.
P sits to the immediate right of S. P sits second to the left of T. V is an immediate
neighbour of U. How many people sit between Q and R when counted from the left of R?

Ans 1. 3

2. 1

3. 2

4. 4

Q.94 Which of the following is not a 'Ghana Vadya'?
Ans 1. Jaltarang

2. Khartal

3. Manjira

4. Mridangam

Q.95 Which keyboard shortcut is used to make the selected text bold in MS Word 365?
Ans 1. Ctrl + I

2. Ctrl + U

3. Ctrl + D

4. Ctrl + B

Q.96 What should come in place of the question mark (?) in the given series based on the
English alphabetical order?

ZYB GFI NMP UTW ?
Ans 1. ABD

2. BAD

3. BDA

4. ADB

Q.97 Which of the following states announced the 'Ama Similipal Yojana' with a budget outlay
of ₹50 crore to enhance livelihoods and promote ecotourism and cultural tourism?

Ans 1. Karnataka

2. Assam

3. Odisha

4. Madhya Pradesh

Q.98 This question is based on the five, three-digit numbers given below.

(Left) 144 743 290 258 799 (Right)

(Example- 697 – First digit = 6, second digit = 9 and third digit = 7)
(NOTE: All operations to be done from left to right.)

What will be the resultant if the second digit of the highest number is subtracted from
the third digit of the lowest number?

Ans 1. −4

2. −6

3. −2

4. −5
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Q.99 What sum of money (in ₹) will amount to ₹720 at 4% per annum simple interest in 5
years?

Ans 1. 600

2. 550

3. 3,600

4. 650

Q.10
0

What is the term duration for representatives in municipalities in India?

Ans 1. 3 years

2. 10 years

3. 7 years

4. 5 years
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